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CHAPTER 1 

     Preface 

 
Thank you for purchasing the TURN-KEY PDI. We are confident that this product will serve you well.  

Any comments you may have concerning this product or your application are encouraged.  Please feel 

free to call, fax or e-mail us at: 

 

    Artium Technologies, Inc. 
    Tel:  (408) 737-2364 

    Fax:  (408) 737-2374 

    E-mail:   info@artium.com 

    Internet: http://www.artium.com 

 

This manual is designed to be comprehensive and easy-to-understand.  However, should you be 

uncertain about how to do certain things, or the consequences of doing something, feel free to contact 

us at Artium Technologies, Inc. We will be happy to answer any questions you may have.  Also, if you 

have any comments on improving this manual, we would appreciate hearing from you. 

 

 

 

 

 

 

 

 

 

 

 

mailto:info@artium.com
http://www.artium.com/
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CHAPTER 2 

     Before you start 

 
Upon receipt of the instrument, inspect the shipping carton for any significant external damage. Unpack 

the unit and inspect for internal damage. If any damage is found, immediately notify the shipper and 

Artium Technologies Inc. 

 

Retain the shipping carton and packing material. If the TK-PDI instrument ever needs repair, the cartons 

will ensure safe shipment of the unit to Artium Technologies, Inc. 
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CHAPTER 3 

     Artium Technologies, Inc. 

  
Artium Technologies, Inc. (“Artium”) was established in 1998 to develop advanced instrumentation 

and to engage in various opportunities associated with laser-based diagnostics for particle field and spray 

characterization. Since its inception, Artium has been actively involved in conducting research and 

development, design, manufacture, and sales/marketing of laser-based instrumentation for particle field 

and spray characterization; for both fundamental research and process/quality control applications.  Our 

instruments have been used in various applications including characterization of sprays used in coating 

medical devices, cloud measurements for aircraft icing research studies, characterizing sprays in spray 

combustion, and measuring soot emissions from diesel engines. We have also developed systems for 

characterizing black carbon for quality control purposes in carbon black production. 

 

Throughout the years, our team has established an excellent record worldwide for providing innovative 

advanced diagnostics that perform reliably under difficult conditions.  Our instruments set the standard 

for performance and for their capability in producing results. 
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CHAPTER 4 

     Warranty 

 
Artium Technologies, Inc. (“Artium”) warrants products of its manufacture against defective materials and 

workmanship for a period of one (1) year from the date of installation by the purchaser or, if shorter, for a 

period of 13 months from the date of shipment to the purchaser. The liability of Artium under this warranty 

is limited, at Artium’s option, solely to repair or replacement with equivalent products, or appropriate credit 

adjustment not to exceed the sales price to the purchaser, provided that: 

 

1. Artium is notified in writing by the purchaser within the warranty period promptly upon the 

discovery of defects, 

2. The purchaser has obtained a Return Materials Authorization Number (“RMA.”) from 

Artium, which RMA number Artium agrees to provide to the purchaser promptly upon 

request, 

3. The defective products are returned to Artium, in the original packing material or alternate 

material approved by Artium, with transportation charges prepaid by the purchaser, and 

4. Artium’s examination of such products discloses to its satisfaction that defects were not 

caused by mishandling of the product, careless operation of the system, negligence, 

misuse, improper installation, accident, or unauthorized attempts to repair or perform 

alterations. 

 

The original warranty period of any product which has been repaired or replaced by Artium shall not 

thereby be extended. 

 

THE FOREGOING WARRANTY IS PROVIDED EXPRESSLY IN LIEU OF AND ARTIUM HEREBY 

DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING ANY WARRANTY OF 

MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, AND OF ALL OTHER 

OBLIGATIONS OR LIABILITIES ON ARTIUM’S PART, AND ARTIUM NEITHER ASSUMES STORE 

AUTHORIZES ANY OTHER PERSON TO ASSUME FOR ARTIUM ANY OTHER LIABILITIES. 

 

The foregoing warranty is only valid for Artium products sold within the United States and Canada.  For 

products sold outside of United States and Canada, please refer to the local authorized Artium distributor 

for applicable warranty terms and conditions. 
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LIMITATION OF LIABILITY 
 

The remedies set forth above constitute the sole and exclusive remedies against Artium for the finishing 

of nonconforming or defective products.  In no event, including if the products are nonconforming, 

effective, delayed, were not delivered, shall Artium be liable for any special contingent, indirect, or 

consequential damages, even if Artium has been advised of the possibility of such damages, whether 

under a contract, tort, property, or other legal theory. Such damages for which Artium is not responsible 

include, but are not limited to, personal-injury, property damage, anticipated profits, labor expended, 

delays, and loss of use. 
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CHAPTER 5 

     About this manual 

 
The purpose of this manual is to provide step-by-step instructions for the proper setup and operation of 

the TK-PDI instrument.  Before attempting to operate the system, the users should familiarize themselves 

with all aspects of laser safety and ensure that laser safety glasses are available to all individuals 

present when the instrument is operated. 

 

This manual provides a description of the steps required in setting up the system which includes two 

transmitters and a receiver optics package, a mounting platform and traversing system (optional), a signal 

processor, and a system computer including the software.  Basic electrical and electronic connections 

for the system are described with diagrams in the manual.  A description of how to install the optics 

packages onto the mounting platform and traverse is outlined.  Basic alignment techniques and 

descriptions of the signal under various alignment conditions are given to help the user recognize when 

the instrument is properly aligned and when it is not.  All optical parameters required for optimal 

measurements are outlined and the means for selecting these parameters are described.  A section on 

the proper setup of the electronic system is given although the system software is designed to 

automatically set these parameters reliably.  The various calculations for the fringe spacing, sample 

volume, and the calculations for the various spray droplet sizes are outlined for easy reference. 
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CHAPTER 6 

     Laser Safety 

 

Explanations of Terms 
 

Cautions and Warnings used throughout this manual are explained below.  Always read and heed this 

information.  It is basic to the safe and proper operation of the system. 

 

WARNING:  Hazardous to persons.  An action or circumstance which may potentially cause personal 

injury or loss of life.  Mechanical damage may also result. 

 

CAUTION:  Hazardous to persons or equipment. To disregard the caution may cause mechanical 

damage, however it is not likely to cause serious injury or death. 

 

Safety Summary 
 
CAUTION: The Solid State Laser Systems (green 532 nm and blue 473 nm) used in the TK-PDI are 

Class 3B lasers. The laser output beams are, by definition, a safety and fire hazard. Precautions must 

be taken to prevent accidental exposure to both direct and reflected beams. 

 

Class 3B lasers are defined by the Federal Register 21 CFR 1040.10 laser safety standard. The standard 

requires that certain performance features and laser safety labels be provided on the product.  

Reproductions of the warning labels are shown in this section. 

 

The American National Standards Institute publishes a laser safety standard for users titled “American 

National Standard for the safe use of lasers” (ANSI Z136.1). Artium Technologies, Inc. recommends that 

laser users obtain and follow the procedures described in this ANSI user standard.  Copies may be 

obtained from: 
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American National Standards Institute Inc. 

1430 Broadway 

New York, NY 10018 

 

OR 

 

Laser Institute of America 

12524 research Parkway 

Orlando, FL 32826 

 

Please refer to the following publications for additional information on laser safety: 
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Laser Safety Labels 
Laser safety labels can be found on various locations both on the outside and inside of the TK-PDI. 

 

WARNING:  Exposure to laser radiation can be harmful.  All apertures which can emit laser energy 

in excess of levels which are considered safe, or areas of the instrument to which exposure to laser 

radiation can occur due to disassembly, are identified with the appropriate label shown in this section.  

Take extreme care when working in areas where these labels are placed. 

 

WARNING:  Instrument users must provide protective eyewear suitable for the lasers emission 

wavelength.  The lasers’ emission wavelengths are indicated in nanometers (nm).  The green laser emits 

at 532 nm.   

 

WARNING:  Use of controls or adjustments or performance of procedures other than those specified 

herein may result in hazardous radiation exposure. 

 

Laser Safety LABELS USED ON THE TK-PDI 
 

                                  
 

 
  
  

 1 
 2 

 3 



 

 
 

Confidential and proprietary information of Artium Technologies, Inc. 
UNAUTHORIZED USE, REPRODUCTION AND/OR DISTRIBUTION IS STRICTLY PROHIBITED. 

10 

LASER SAFETY LABEL PLACEMENT ON THE TK-PDI OPTICAL HEAD 
 

 
Figure 6.1:  Laser beams exit window A and are stopped by beam block B. 

 

 

  

 1 

 3 

 2 

  A   
  B   
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CHAPTER 7 

     Hardware setup/connection 

 

TK-PDI Major Components and connections 
1) TK-PDI Optical Head 

2) ASA Signal Processor 

3) Computer 

 

            

Figure 7.1:  The Artium TK-PDI System. 

 

Figure 7.1 shows the components of the TK-PDI with labels describing each electronics and optics 

enclosure. A description of the connectors on the electronics and optical enclosures is provided in figure 

7.2.  In general, the electronic connections can only be made to the proper connectors. However, care 

must be taken in connecting the signal cables to the proper locations, namely connectors labeled as Input 

Signals (BNC connectors) on the ASA Signal Processor must be connected to Input 1A, 1B, and 1C with 

 

 1 

 2 

 3 
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the labeled cables from the receiver cable. Care must be taken to carefully align connectors before 

plugging them in so that the pins are not damaged or misaligned.   

 

 

    Figure 7.2: Connections for the TK-PDI Instrument. 

 

Descriptions of the Connections 

 

In this section, each of the connections on the electronics and optical enclosures will be described and 

will refer to figure 7.2. 

 

1. TK-PDI Cable 
This six-meter cable connects the optical head to the signal processor. The cable includes three raw 

signal coaxial cables (indicated as 5 in figure 7.2) and communicates the settings and other functions to 

the signal processor. This cable is indicated as 1 in figure 7.2. 

 1 

 1 

 3 

 2 

  
4   

  5   
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2. High-Speed Data Cable 
Not shown, is the cable that connects the ASA signal processor to the I/O card plugged into the computer. 

Digitized data is transmitted back to the computer through the high-speed interface card. For ASA2 

systems (shown here), the cable is a standard Cat5 ethernet cable.  For ASA3 systems, the cable is an 

optical fiber. This cable connection location is indicated as 2 in Fig. 7.2. 

3. Interlock 
This connector allows a laser interlock switch located on the door or other access to the laboratory to 

be activated so that when a connection is broken via the interlock switch, the laser will shut off. For the 

TK system to operate, this circuit must be closed either thru the door switch or with the shorting cap 

provided. The interlock is indicated as 3 in figure 7.2. 

4. A/C Adaptor 
The system is powered by the included 110-240VAC Input; to 24VDC Output; 120w adaptor. Only use 

this adaptor or others meeting the same specifications to ensure safe, continued operation of the 

instrument. The adaptor is indicated as 4 in figure 7.2. 

 

ASA Signal Processor CH 1 
The ASA signal processor accepts the Doppler burst signals from the TK-PDI and amplifies and filters 

the incoming analog signals, performs digital and analog signal detection, and presents information on 

the detected digitized signals to the computer via a high-speed interface card. The signals are processed 

to produce the size and one component of velocity of the droplets. The following connections are required 

for proper operation of the instrument. 

 

Input Signals 
The BNC cables provided with the instrument must be connected to the proper BNC connectors on the 

ASA signal processor. The cables are labeled 1A, 1B, and 1C. The other end of the cable is connected 

to the TK-PDI enclosure indicated as 5 on Fig. 7.2. 

 

RAW A, RAW B, and RAW C BNC Connectors 
These connectors are used as monitor points for observing the signals with an oscilloscope.  The signals 

at these points are identical to the signals entering the signal processor at the input signal connectors. It 

is useful to observe the raw signals with an oscilloscope during alignment of the instrument and during 



 

 
 

Confidential and proprietary information of Artium Technologies, Inc. 
UNAUTHORIZED USE, REPRODUCTION AND/OR DISTRIBUTION IS STRICTLY PROHIBITED. 

14 

operation to ensure that the quality of the signals is adequate and that there are no problems with the 

incoming signals. 

 

OUT A, OUT B and OUT C BNC Connectors 
These monitor points allow the observation of the signals after they have been filtered by the low pass 

and high pass filters and amplified logarithmically. The signals observable at this point are digitized and 

that information is passed to the computer for processing using the complex Fourier transform. 

 

GATE OUT BNC Connector 
This monitor point allows the observation of the gate signal which rises to approximate level of 5 V when 

a signal is detected and falls at the end of the signal.  This information is useful in observing the 

performance of the Doppler signal burst detection. 

 

EXTERNAL INPUT 
This connection point allows the input of information from other data gathering devices such as pressure 

monitoring, temperature monitoring, etc. These data are then appended to the data stream being 

transmitted to the computer for processing. It can also be connected to a resettable clock so that 

ensemble averages can be obtained from pulsed injections, for example. 

 

WARNING: Instrument users must provide protective eyewear suitable for the lasers emission 

wavelength.  The laser emission wavelength is indicated in nanometers (nm).  The key in the back of the 

transmitter enclosure turns the lasers on or off. If the power box is turned Off and On again, the key switch 

must be turned Off and then On to start the laser.  

 

This enclosure contains the green laser which produces hazardous light beam intensities.  Caution must 

be taken in operating the system and protective eyewear must be used when performing alignment.  

Enclosure also contains the appropriate optics and a Bragg cell is used to shift the frequency and split 

each laser beam into two equal intensity beams.  
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TK-PDI Mounting Options 
 

The TK-PDI enclosure can be mounted to an optical table, optical rails, or other supporting fixtures. 

 

Figure 7.3: Schematic showing the TK-PDI 1 enclosure mounting holes. 
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Figure 7.4: Schematic showing the TK-PDI 1 working distance without purge hoods. 

 

 
 

Figure 7.5: Schematic showing the TK-PDI 1 working distance with purge hoods. 
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Figure 7.6: Schematic showing the TK-PDI 2 enclosure mounting holes. 

 

 

Figure 7.7: Schematic showing the TK-PDI 2 working distance without purge hoods. 

 

Figure 7.8: Schematic showing the TK-PDI 2 working distance without purge hoods. 
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Purge hoods / beam shields 
 

The TK-PDI is supplied with hoods that protect the windows from droplets, provide anti-fogging, and 

protect the light paths in cases of high number density sprays. The purge hoods require both 

pressurized air and vacuum, and they operate on low air pressure (5-10 psi) and low flow rate. 

Each hood attaches to the housing with a single M3 cap head screw. 

 
Figure 7.9: Beam shield / purge hoods installed on a TK2. 
 

The design goal is that no air will exit the purge hood and affect the spray flow, but droplets will 

be prevented from entering the hoods and reaching the windows. 

 

In most cases, the hoods alone are adequate to shield the beams and protect the windows from droplet 

accumulation. When this is not the case, the hoods are designed to work with both purge air and vacuum. 

Figures 7.10 and 7.11 show the external and internal construction of the hoods. There is a plenum for 

purge air that can be supplied via the PURGE port on the hood. Clean Dry Air (CDA) from a compressor 

or pressure cylinder source, or nitrogen, is required (not supplied by Artium). Artium supplies a pressure 

regulator and tubing. 

 

         
Figure 7.10: Purge hood external construction. 
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Figure 7.11: Purge hood internal construction. 

 
The air enters the hood through radial ports along the inner circumference of the hood. This will create a 

slight positive pressure relative to the test flow and aid in keeping small droplets out of the hood and 

moisture from condensing on the TK windows. Some of this purge air will exit the hood through the open 

end and enter the test flow. It is important that this air not adversely affect the external flow under test. 

Only the minimum amount of purge air (a few psi pressure) should be used, and tests should be run to 

confirm that the test flow is not affected by the purge.  

 
Figure 7.12: Purge hood plumbing supplied by Artium. 

 

In cases where purge air is a necessity and there is the possibility that the air exiting the hood is affecting 

the external test flow, there is a separate plenum from which air can be drawn out of the hood.  That port 

is labeled VACUUM.  Artium does not supply plumbing for this feature. The vacuum plenum will draw air 

in through radial ports along the inner circumference of the hood. The purge and vacuum flowrates must 

be balanced so the net flow to the hood is zero. Too much vacuum can also adversely affect the external 

test flow. 
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CHAPTER 8 

     Software setup 

 

AIMS INTRODUCTION 

Artium Instrument Management Software (AIMS) is a software application for controlling 

hardware, data acquisition, data storage, and data analysis.  AIMS works with a variety 

of hardware including: 

 
• PDI/LDV (Phase Doppler Interferometry/Laser Doppler Velocimetry) 

• LII (Laser-Induced Incandescence) 

• High-Speed Imaging 

• Traverse (Positioning) Systems 

• DAQ (analog and digital I/O) boards 

 
AIMS runs on the Microsoft Windows platform, specifically Windows 7 and higher.  Older 

versions of AIMS ran on Windows XP, but Windows XP is no longer supported. 
 

AIMS GENERAL OPERATION 
This section covers general (not specific to any instrument) operation of AIMS. 
 

AIMS has four (4) buttons on the left side of the AIMS window: Data Library, Device 

Controls, Results, and Export.  These control what is displayed in the AIMS window and 

change how the AIMS window operates: 
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Data Library 
The Data Library organizes and displays data files for AIMS: 
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As files are acquired or added to AIMS, they will appear in the Data Library.  The left 

side of the Data Library is a tree for navigation of directories containing AIMS data 

files.  The runs table on the right side is updated to show available runs in the currently-

selected directory. 
 

To open a run, double-click on the run name in the runs table.  AIMS will switch to the 

Results mode and display data as the run is loaded. 
 

Right-clicking on a directory brings up a menu with the following options: 
Show Data Directory in Windows Explorer… 

Opens a Windows Explorer folder displaying the directory 
Reload Data Directory 

Reloads (scans) the data directory for AIMS data files.  If AIMS data files 

are added to the directory manually (not through AIMS), then this will add 

the files to the AIMS Data Library. 
 

Right-clicking on a run brings up a menu with the following options: 
Show Data File in Windows Explorer… 

Opens a Windows Explorer folder displaying the run 
Add Tag to Run… 

Tags are small phrases that can be associated with a run file.  Tags can 

be used to find runs across the entire Data Library.  For example, you 

may wish to mark runs with a name for a project (maybe “Project A”). 
Remove Tag from Run… 

Removes a selected tag from a run. 

 

Device Controls 

This mode displays the controls and settings for devices controlled by AIMS.  Each 

device has one or more tabs covering aspects of operation (settings, calibration, etc.). 
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IMPORTANT: Changes made to settings in the Device Control mode only affect the 

current state of the instrument and do not have any effect on existing (saved) data/runs. 
 

The available tabs will depend on what instrument(s) are controlled by AIMS and are 

device-specific.  There are two default tabs that are always present: Acquisition and 

Notes. 
 

The Acquisition tab set the conditions for AIMS to stop data acquisition: 
 

Time 

Acquisition will stop when the set time is reached. 
# Signals 

Acquisition will stop when the number of signals/samples is reached.  For 

PDI/LDV, this is the number of valid samples.  For LII, this is the number 

of laser shots.  For Imaging, this is the number of frames. 
Time OR # Signals (whichever is first) 
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Acquisition stops when either the time or number of signals criterion is 

met. 
Free Run 

Acquisition stops only when the user stops (via the Stop button or the 

<Esc> key). 

 
Results 
Results mode displays data from one run - either loaded from disk or recently 

acquired.  Each tab represents a different view of the data (graphs, tables, fields, etc.).  

Tabs/Views can be added from the Views menu. 
 

 
 

Tabs.Views can be closed by selecting Views > Close Current View or by 

pressing <Ctrl><W>. 
 

You can rearrange the order of the tabs/views by clicking and holding on a tab title and 

then dragging left or right.  When you release the mouse button the tab will be moved. 
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To scroll the tabs, move the mouse cursor to the tab titles and then rotate the mouse 

scroll wheel. 

 
Export 
The Export mode controls how data is exported from AIMS to common formats. 
 

 
 

Exporting from AIMS is covered in the section Exporting Data From AIMS. 
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Menus 

File Menus 
 

Open Run 
 

Opens a file chooser dialog to select one (1) run.  The run is loaded and added to the 

Data Library: 
 

 
 
Add Run(s)... 
Opens a file chooser dialog (like Open Run), but only adds the run to the Data Library 

(the run is not loaded and analyzed).  
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Add Directory... 
Opens a directory chooser dialog (see below) to add all the runs in the selected directory 

to the Data Library. 
 

 
 
Show Data Library 

Switches AIMS to the Data Library mode (same as clicking on the Data Library 

button on the left-side of the AIMS window). 
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Load Selected Runs… 
Displays a dialog to load selected runs (from the currently-selected directory).  Selected 

runs are loaded one after another.  This is intended for use with graphs that plot data 

from multiple runs. 
 

 
 
Page Setup… 
Displays the printer page setup dialog for setting printing parameters: 



 

 
 

Confidential and proprietary information of Artium Technologies, Inc. 
UNAUTHORIZED USE, REPRODUCTION AND/OR DISTRIBUTION IS STRICTLY PROHIBITED. 

29 

 
 
Print Current Page… 
Prints the currently selected view/tab. 

 
Configuration Menu 
 
Create Configuration, Select Configuration, Edit Configuration 

These options are covered in the Configurations section of this manual. 

 
Hardware > Set Device Profiles… 
Displays the Set Device Profiles dialog used to tell AIMS what hardware to look for on 

startup.  If you make any changes in this dialog, you will need to restart AIMS for them to 

take effect. 
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IMPORTANT: Unless directed by Artium, you should not need to make any changes to 

the selected device profiles. 
 

 
 
Hardware > Backup Device Databases… 
Makes a backup (.zip file) of all the current device databases and displays a file chooser 

dialog to specify where to save the backup.  The device database files contain all of the 

settings, parameters, and calibration information needed for operation and data analysis 

using the connected hardware. 

 
Hardware > Restore Device Databases… 
Restores the device databases using a previous backup.  Note that AIMS makes a 

backup copy of the device databases on each startup.  Restoring to a backup overwrites 

the existing device settings, parameters and calibration. 
 

IMPORTANT: Unless directed by Artium, you should not need to restore the device 

databases. 

 
Preferences 
Displays the Preferences dialog: 
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The AIMS Data Library Directory is the location where new runs (data) are 

saved. 
 

If Automatic Acquisition Directory Creation is enabled, AIMS will create 

directories based on the current date (for automatic organization).  For example, if the 

date was August 5, 3025, AIMS would create the following directories: 
 

AIMS Data 
\3025 

\08 
\05 

 

Show Tool Bar Button Text controls whether tool bar buttons also have text 

displayed: 
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 vs.  

 

Set Preferred Units… 

Displays a dialog to set preferred display units for various quantities: 
 

 
 

Any changes will be reflected the next time AIMS starts.  Contact Artium for more 

information about available units. 
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Set Preferred Number Formats... 
Displays a dialog to set preferred formats for various quantities.   
 

 
 

Any changes will be reflected the next time AIMS starts. 

 
Export Menu 

The functionality of the Export menu is detailed in the Exporting Data From AIMS 

section. 
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Acquisition Menu 
 
Show Device Controls 
Displays the Device Controls mode in AIMS. 

 
Acquisition Settings… 
Displays the acquisition settings dialog: 
 

 
 

The Repeat Acquisition field can be use to repeat acquisition automatically when a 

run ends.  This is useful for breaking up long runs or to acquire data for extended 

periods of time. 
 

If Start Acquisition When AIMS Starts is enabled, data acquisition will begin 

immediately after AIMS has completed the startup process (finding devices, loading 

views, etc.). 

 
Start Data 
Starts data acquisition.  Data is automatically saved to disk. 

 
Stop Data 
Stops data acquisition or stops loading a run from disk. 

 
Quick Check (Not Save To Disk) 
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Starts data acquisition, but the data is NOT saved to disk.  This is intended for 

testing/alignment where the runs are not meant to be saved. 

 
Views Menu 
 
Show Results 
Switches AIMS to the Results mode for displaying data (both live acquisition and loading 

from disk). 

 
Previous Tab 
Switches to the next tab (to the right of the current tab).   The keyboard command 

<Ctrl><Left Arrow> does the same thing. 

 
Next Tab 
Switches to the previous tab (to the left of the current tab).  The keyboard command 

<Ctrl><Right Arrow> does the same thing. 
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Show Tab Selector 
Displays the tab selector, a preview of all open tabs: 
 

 
 

Clicking on a thumbnail for a tab will open that tab. 

 
Close Current View 
Closes the currently-selected tab/view. 

 
Close Views With Multiple Runs 
Closes all tabs/views that display data from multiple runs at one time.  Most tabs/views 

show data only from the currently-selected run at one time. 

 
Custom > New Custom Graph View 
For more information on this option, see the section Plotting Data Versus Traverse 

Position for an example. 
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Scripts Menu 

The Scripts menu is for running and creating AIMSScript programs.  AIMSScript is a 

simple command language for AIMS to automate repetitive tasks (like mapping out a 

spray using a positioning system). 
 

For information on the syntax/format of AIMSScript see the section AIMSScript. 

 
Run Script… 

AIMS will present a file selection dialog.  Select the script to run which should have a 

.script extension) and AIMS will parse the script.  If no syntax errors are found, the AIMS 

will open a window to show the progress of running the script.  If any syntax errors are 

found, AIMS will display them in the script window. 

 
Create Script From Points File… 
See the AIMSScript section for more information. 

 
Network Menu 

The options in the Network menu are explained in the AIMS Remote Connection 

section. 

 
Help Menu 
 
Display Help Contents 

Displays the AIMS built-in help viewer: 
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About This Program 

Displays a dialog that shows version information about AIMS: 
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Show Changelog 
Displays the changelog for AIMS: 
 

 
 
Show Settings Directory… 
Opens the AIMS settings directory in Windows Explorer. 

 
Save Current Log File… 
Displays a file chooser dialog to specify a location to save the current AIMS internal og 

file. 

 
Add Note to Log File… 
Adds a note to the AIMS internal log file (for troubleshooting). 

 
Capture Screen to PNG… 
Takes a screenshot of the AIMS window and saves it to the PNG (Portable Network 

Graphics) format. 
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Contact Artium… 
If the computer running AIMS is connected to the Internet, you can submit the current 

log and/or run files directly to Artium via AIMS.  Selecting Help > Contact 

Artium... from the AIMS menu displays the Send Message to Artium dialog: 
 

 
 

Make sure to include a valid email address to enable Artium to reply to your message. 

 
Browse to artium.com 
Opens the artium.com website in your default browser. 

 
Check For Update… 
Checks for an available update to AIMS.  This functionality is still being developed. 

 

 

  



 

 
 

Confidential and proprietary information of Artium Technologies, Inc. 
UNAUTHORIZED USE, REPRODUCTION AND/OR DISTRIBUTION IS STRICTLY PROHIBITED. 

42 

AIMSScript 

Introduction 
AIMSScript is a simple, yet powerful, method for automating AIMS data acquisition. 

 
Running an AIMSScript Program 
To run an AIMSScript program, select Scripts > Run Script... from the program 

menu.  AIMS will present a file selection dialog.  Select the script to run which should 

have a .script extension) and AIMS will parse the script.  If no syntax errors are 

found, the AIMS will open a window to show the progress of running the script.  If any 

syntax errors are found, AIMS will display them in the script window.  

 
Syntax 
AIMSScript uses a simple format - each line is a command. 
 
Whitespace  is ignored (except end-of-line/carriage returns). 

 
Lines starting with # are non-executing comments: 

 
# This is a comment. 

 

The first word in a script line is a command, followed by any arguments separated by 

commas: 
 

Pause,500 

 

Variables (currently only defined in for-loops) are preceded by $ and may not contain 

any spaces: 
 

Valid: $xPosition OR $MyVariable 

Invalid: missingADollarSign OR $Variable with spaces 
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Variable and command case is not important: Pause is equivalent to PAUSE 

 
Case is important to arguments: 
 

SetNodeValue,"A3200 Channel X Position",300 

 
is not the same as 
 

SetNodeValue,"a3200 channel x position",300 
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Traverse Simple Node Paths  

ACS (Serial Port) 
ACSSerial Is Traverse Moving 

Value of 0 indicates traverse has stopped moving. 
ACSSerial Channel X Position 

X-axis position. Y and Z axes are the same format. 

 

ACS Tech 80 
ACS Tech80 Is Traverse Moving 

Value of 0 indicates traverse has stopped moving. 
ACS Tech80 Channel X Position 

X-axis position. Y and Z axes are the same format. 

 

Aerotech A3200 
A3200 Is Traverse Moving 

Value of 0 indicates traverse has stopped moving. 
A3200 Channel X Position 

X-axis position. Y and Z axes are the same format. 

 

Aerotech Soloist 
AerotechSoloist Is Traverse Moving 

Value of 0 indicates traverse has stopped moving. 
AerotechSoloist Channel X Position 

X-axis position. Y and Z axes are the same format. 

 

American Precision Industries (Serial Port) 
AmericanPrecisionIndustries Is Traverse Moving 

Value of 0 indicates traverse has stopped moving. 
American Precision Industries Traverse Channel X Position 

X-axis position. Y, Z, and W axes are the same format. 
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Compumotor 6K 
Compumotor6K Is Traverse Moving 

Value of 0 indicates traverse has stopped moving. 
Compumotor6K Channel X Position 

X-axis position. Y, Z, and T axes are the same format. 

 

isel Microstep C142 
isel Is Traverse Moving 

Value of 0 indicates traverse has stopped moving. 
isel Channel X Position 

X-axis position. Y and Z axes are the same format. 

 

Manual Traverse 
Manual Traverse X Position 

X-axis position. Y and Z axes are the same format. 

 

OWIS PS90 
OWIS PS 90 Is Traverse Moving 

Value of 0 indicates traverse has stopped moving. 
OWIS PS 90 X Position 

X-axis position. Y and Z axes are the same format. 

 

Seika 
Seika Is Traverse Moving 

Value of 0 indicates traverse has stopped moving. 
Seika X Position 

X-axis position. Y and Z axes are the same format. 

 

Sigma-Koki PAT-001 
PAT-001 Is Traverse Moving 
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Value of 0 indicates traverse has stopped moving. 
PAT-001 Channel X Position 

X-axis position. Y and Z axes are the same format. 

 

Parker ACR9000 
Parker ACR9000 Is Traverse Moving 

Value of 0 indicates traverse has stopped moving. 
Parker ACR9000 Traverse Channel X Position 

X-axis position. Y, Z, and W axes are the same format. 

 

Primatics MDC1800 
Primatics MDC1800 Is Traverse Moving 

Value of 0 indicates traverse has stopped moving. 
Primatics MDC1800 X Position 

X-axis position. Y and Z axes are the same format. 

 

Unidex 11/12 
Unidex 11 Is Traverse Moving 

Value of 0 indicates traverse has stopped moving. 
Unidex 11 Channel X Position 

X-axis position. Y and Z axes are the same format. 

 

Velmex VP9000/VXM 

Velmex Is Traverse Moving 

Value of 0 indicates traverse has stopped moving. 
Velmex Channel X Position 

X-axis position. Y, Z, and T axes are the same format. 

 

Yaskawa SMC4000 
Yaskawa Is Traverse Moving 

Value of 0 indicates traverse has stopped moving. 
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Yaskawa SMC-4000 Channel X Position 

X-axis position. Y, Z, and W axes are the same format. 
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Creating an AIMSScript Program 
Manual 
 
Open a text editor and type in the AIMSScript by hand.  The extension of the file should 

be .script 

 

Using a Points File 
This method takes a list of nodes to set, along with a list of values for those nodes 

generates an AIMSScript program automatically. 
 
For example, if we wanted to move an Aerotech A3200 traverse system across a set of 

points, we might use a points file like: 
 

A3200 Channel X Position,A3200 Channel Y Position 
100,300 
200,350 
300,450 
,465 

 
to generate a script program of: 

 
# Generated by AIMS from points.script at Thu May 19 

15:40:24 PDT 2005 
SetNodeValue,A3200 Channel X Position,100.0 
SetNodeValue,A3200 Channel Y Position,300.0 
StartAcquisition 
SetNodeValue,A3200 Channel X Position,200.0 
SetNodeValue,A3200 Channel Y Position,350.0 
StartAcquisition 
SetNodeValue,A3200 Channel X Position,300.0 
SetNodeValue,A3200 Channel Y Position,450.0 
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StartAcquisition 
SetNodeValue,A3200 Channel Y Position,465.0 
StartAcquisition 

 

The first line in the points file defines the nodes to be set.  The remaining lines are the 

values to set.  Note that the last line of the points file only specifies a value for the Y-

axis, and that the last set of commands in the script file only include the Y-axis. 
 

In addition to text files, you can also define the points in a Microsoft Excel spreadsheet 

(even using formulas to define the points).  There are some caveats: The points must be 

on the first sheet of the workbook/spreadsheet, and the node names and points must be 

the only values on the first sheet. 
 

 
 
AIMSScript Command Reference 
 
Pause 
Syntax 

Pause,time 

Description 
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The Pause command causes AIMS to pause for a specified amount of time (in 

milliseconds). 
Example 

Pause,500 

 

StartAcquisition 
Syntax 

StartAcquisition 

Description 
The StartAcquisition command starts data acquisition. It does not take any 

arguments. 
Example 

StartAcquisition 

 

SetNodeValue 
Syntax 

SetNodeValue,node name,value,units 

Description 
The SetNodeValue command sets a device node value.  The node name is the 

one-line node name (like A3200 Channel X Position).  The value is the 

value to set (like 23.5).  For traverse commands, the units are #. 

Example 
SetNodeValue,A3200 Channel X Position,23.5,# 

 

WaitForNodeValue 
Syntax 

WaitForNodeValue,node name,value,units 

Description 
The WaitForNodeValue pauses a script until the specified node has the 

requested value.  The node name is the one-line node name (like A3200 Is 
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Traverse Moving).  The value is the value to wait for (like 0 for traverse 

movement to stop).  For traverse commands, the units are #. 

Example 
WaitForNodeValue,A3200 Is Traverse Moving,0,# 

 

For 
The For command implements a for-loop - a loop that executes a fixed number of 

times.  Additionally, the for-loop defines a loop variable which is updated every trip 

through the loop and can be used by commands inside the for-loop. 
 
Syntax 

for,$variable,start value,end value,num values 
endfor 

Description 
The variable name must start with a $ and not have any spaces (like 

$loopvariable).  The start value is the first value that the variable will be set 

to.  After the first value, the variable will be set to start value + (delta * current 

step).  delta is defined as (end value - start value) / (num values - 1 ). current 

step is an integer value that ranges from 0 to num values. 
Example: 

for,$loopvariable,1.5,10.8,4 
    SetNodeValue,A3200 Channel X Position,$loopvariable 
    StartAcquisition 
Endfor 

 
This is equivalent to: 
 

SetNodeValue,A3200 Channel X Position,1.5 
StartAcquisition 
SetNodeValue,A3200 Channel X Position,4.6 
StartAcquisition 



 

 
 

Confidential and proprietary information of Artium Technologies, Inc. 
UNAUTHORIZED USE, REPRODUCTION AND/OR DISTRIBUTION IS STRICTLY PROHIBITED. 

52 

SetNodeValue,A3200 Channel X Position,7.7 
StartAcquisition 
SetNodeValue,A3200 Channel X Position,10.8 
StartAcquisition 

 

Note that for-loops can be nested, so the following is legal syntax: 
 

for,$x,1.5,10.8,4 
    for,$y,-5,5,10 
        SetNodeValue,A3200 Channel X Position,$x 
        SetNodeValue,A3200 Channel Y Position,$y 
        StartAcquisition 
    endfor 
endfor 

 

Plotting Data Versus Traverse Position 
(Custom Views) 

2012-08-07 

 
Introduction 
This document details how to create a custom plot of data versus traverse position.  The 

plot can be updated in real-time during a traverse scan, or loaded later from saved 

data.   

 

Create Custom View 
The first step is creating a custom view to hold the new plot.  Select Views > Custom > 
New Custom Graph View... and enter a name for the new view: 
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After entering the name, click Save.  To open the custom view (using the name in the 

example above), select Views > Custom > Velocity Versus Position: 
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Set Plot Title 
Note that the plot and axis titles are are set to FIXME.  To change the plot title, right-click 

on the plot and select Set Graph Title....  In this example we will title the plot Velocity vs. 

X Position: 
 

 
 
Define Axes 
To define the X and Y axes, we need to select data from other views in AIMS.  We’ll 

assume the Doppler Mode is set to 1D PDI for this example, but data from any mode is 

fine.  All data must be single-valued, i.e., velocity mean or D32, but not velocity versus 

time. 

 

Y-Axis 
To set the Y-axis, we’ll open the PDI Statistics view (Views > PDI > Results > PDI 
Statistics).  Then right-click on the Average Velocity field and select Copy Definition to 
Clipboard.  Now select the Velocity Versus Position view and right-click on the plot and 

choose Set Y Axis Definition From Clipboard: 
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X-Axis 
In this example, the X-axis of the plot will be the position of the x-axis of the traverse. 

There are two places to get the definition of the x-axis position - choose it from the 

Device Controls traverse view, or select the traverse in Views > Traverses. We will use 

the isel iMC-S8 controller in this example, so select Views > Traverses > Isel iMC-S8: 
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Right-click on Axis 1 Position and select Copy Definition to Clipboard.  Then select the 

Velocity Versus Position view and right-click on the plot and choose Set X Axis 
Definition From Clipboard: 
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That’s all there is to creating a custom view - we are finished. 

 

Notes 
If you acquire data, it will be added to the plot automatically.  If you change directories, 

the plot will be cleared.  You can also clear the plot by selecting Views > Clear Views 
with Multiple Runs. 
 
You can also load saved data and the plot will include this data.  To load multiple runs 

(to populate the plot), select File > Load Selected Runs.... 
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AIMS Troubleshooting 

Having trouble with AIMS?  This section includes steps to prevent problems and steps 

that will help you resolve issues. 

 

Backing Up Important Files 
AIMS has a variety of files needed for correct operation.  These files all reside in the 

Settings directory.  You can access the Settings directory from AIMS by selecting Help > 

Show Settings Directory - this will open the Settings directory in the Windows Explorer: 
 

 
 

IMPORTANT - The files in the Settings directory contain calibration data (and user 

settings) so they should not altered, modified, or moved. 
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The location of the Settings directory depends on the version of Windows you are using: 
 

Windows XP 
C:\Documents and Settings\All Users\Application 

Data\Artium\AIMSX_Y 
 
Windows 7 

C:\ProgramData\Artium\AIMSX_Y\log 
 

Where X_Y is the AIMS version (i.e, 5_0 for AIMS 5.0). 

 
When backing up the Settings directory, make sure to copy the entire contents.  The 

backup should be made on another computer or drive that is separate from the computer 

running AIMS. 

 

Log Files 
When running, AIMS creates a log file that contains information about what AIMS is 

doing and also any errors encountered during operation.  This log can be useful to 

Artium when troubleshooting issues.  Log files are not designed for users to interpret - 

there is no strict format and may change at any time. 
 

For each day of operation, AIMS creates a log file in the log directory of the Settings 

directory.  The name of the log file is standaloneYYYY-MM-DD.log, where 

YYYY=year (2018), MM=month(03 for March), and DD=day of month. 

 

Contacting Artium 
If the computer running AIMS is connected to the Internet, you can submit the current 

log and/or run files directly to Artium via AIMS.  Selecting Help > Contact 

Artium... from the AIMS menu displays the Send Message to Artium dialog: 
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Make sure to include a valid email address to enable Artium to reply to your message. 
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AIMS Remote Connection 

Introduction 
AIMS can connect to another version of AIMS or an Artium LII-300 instrument via a 

network connection.  This allows full access to the remote AIMS/LII-300 and also the 

ability to copy data back to the local version of AIMS.  For the LII-300, this also allows for 

more detail/in-depth analysis of LII results. 

 

Compatibility 
AIMS versions after 5.0 and LII-300 versions after 9.0 are not network-compatible with 

older versions. 

 

Requirements 
To connect to another version of AIMS, the two computers must be connected via 

network (Ethernet).  You can make a simple network with a router and two ethernet 

cables.  Most “home” routers will automatically supply IP (Internet Protocol) addresses 

and route information between any computers attached to them. 

 

Getting Started 
The first step is to make sure the remote computer has access enabled. 

 

Enable Remote Access (AIMS/Windows) 
On the remote computer make sure AIMS has a checkmark next to the Listening item 

in the Network menu: 

 

 
 

If not, select Listening to enable it. 
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Enable Remote Access (LII-300) 
Remote Access allows a normal version of AIMS to talk to the LII-300 via a network 

connection.  Remote Access can be enabled or disabled via the front panel of the LII-

300.  To reach the Remote Access screen, select Home > Settings > Remote 

Access: 

 
 
Press the Update button to verify the IP address of the LII-300. You will need this and 

the Port Number to connect AIMS to the LII-300. 

 

Finding IP Address (AIMS/Windows) 
In AIMS, select Network > Show Network Address(es).  This will display a dialog with 

any network addresses that the computer has (there may be more than one): 
 

 
 

Connect to Remote AIMS/LII-300 
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In the local instance of AIMS, select Network > Connect to Remote 

AIMS...  This will open the Socket Connection dialog: 

 

 
 

Enter the IP Address and Port number of the remote AIMS/LII-300.  The default Port is 

8888. 
 
Quit and restart AIMS.  When AIMS restarts, it will attempt to connect to the remote 

AIMS/LII-300.  Remote operation will be a little slower than standalone/local operation 

since AIMS must retrieve data and information from the remote computer. 
 
When in remote/network mode, AIMS has full access to the remote AIMS - you can 

start/stop acquisition, load data, change device settings - anything you would normally 

do when AIMS is running in local mode. 

 

Copying Data from Remote AIMS/LII-300 
To copy data from the remote AIMS to the local computer, open a run and then click on 

the download button: 
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Switching Back To Local/Standalone Mode 
To switch the local AIMS back to local/standalone mode (this means AIMS will get all 

data, etc. off the local hard drive instead of via the network), select Network > 

Standalone and restart AIMS.  
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Moving AIMS to Another Computer 

2017-11-27 

 

Introduction 
This document details how to correctly move an AIMS installation on an existing (old) 

computer to a new computer while preserving all data, settings, and other important 

files.  Although AIMS supports other operating systems, the instructions below assume 

the operating system is Windows (7, 10, etc.). 

 
Preparation on Existing Computer 
 

Copying Settings 
Start AIMS on the old computer and select Help > Show Settings Directory 

from the menu.  This should open a Windows Explorer folder: 
 

 
AIMS Setting Folder - Windows 10 shown. 
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Note that in older versions of Windows (XP), the folder may be different.  Navigate to the 

root of the Artium settings directory by clicking on the word Artium in the navigation bar 

(see figure).  You should see a list of previous AIMS settings folders: 
 

 
Example of AIMS Setting Folders 

 

Right-click on the latest folder and choose Send To > Compressed (zipped) 

folder: 
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This will create a zipped file that contains all of the settings for AIMS.  This will need to 

be moved to the new computer. 

 

Copying Data 
On the old computer, start AIMS and click on the Data Library button to open the 

Data Library view in AIMS.  Next, right-click on the AIMS Data folder and choose Show 

Data Directory in Windows Explorer…  This should open a Windows Explorer 

folder that shows the data acquired by AIMS.  The contents of this folder will need to be 

moved to the new computer (see below). 
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Setup on New Computer 
 
Driver Installation 
Before installing AIMS, you need to install any necessary device drivers (that match the 

version of AIMS you are installing).  This may include a driver for a RS-232/Serial to 

USB converter (depending on your instrument). 

 
AIMS Installation 
Run the AIMS installer.  This will copy AIMS to the hard drive of the new computer and 

setup application links, etc.  DO NOT START AIMS AT THIS TIME! 

 

Copying Settings 
In Windows Explorer, navigate to C:\ProgramData.  You may need to change 

Windows settings to see this folder: 
 

1. Select the Start button, then choose File Explorer. 

2. Select the View tab. 

3. Check the Hidden items check box to view hidden items. 

 

Inside the ProgramData directory, create an Artium directory.  Note that case is 

important. 
 

Navigate to the Artium directory and copy the settings backup file (.zip) from the old 

computer to this directory.  Unzip the file by right-clicking on it and choose Extract 

all…  This will extract the settings files in the correct location. 

 

Copying Data 
Navigate to the Documents directory in Windows Explorer.  Create an AIMS Data 

directory (note that case is important and there is a space between the two 
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words).  Navigate to the AIMS Data directory.  Copy the data from the old computer 

here. 

 

Start AIMS 
At this point you should be able to start AIMS on the new computer with all the hardware 

connected.  It should start normally with all of the devices, settings, and data from the 

old computer.  Note that it may take a little longer to start the first time as AIMS checks 

connections, finds serial ports, and verifies data file locations. 
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AIMS Preferred Units and Formatting 

2011-08-05 

 

Introduction 
Internally, AIMS tracks units for each node (number or array of numbers).  The user 

can’t change this internal value.  The user can, however, change the unit used to display 

the node value on the screen (or exported to a file).  The same applies to the format 

(number of digits, scientific notation) of how the number value is displayed. 

 

Preferred Units 
AIMS has a preferred units file, units.preferences.  From AIMS, select Help > 

Show Settings Directory..., then open the config directory.  Using a UTF-

aware editor (like jEdit), you can change the units that AIMS uses when displaying 

values to the screen.  Here’s an example file for LDV/PDI systems: 
 

#Units Preferences 
#Tue Jul 06 12:57:28 PDT 2010 
${LDV_VelocityUnits}=m/s 
${PDI_DiameterUnits}=µm 
${PDI_LiquidWaterContentUnits}=g/m³ 
${PDI_NumberDensityUnits}=1/cm³ 
${PDI_VolumeFluxUnits}=cm/s 
${PDI_VolumeUnits}=cm³ 

 
In the above example, velocity values will be displayed in meters per second (m/s).  To 

display results in miles per hour, the velocity line would be changed to: 
 

${LDV_VelocityUnits}=mph 

 
You could use other units, like centimeters per second (cm/s) or microns per 

second(µm/s). 
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After changing this file, you will need to restart AIMS for the changes to take effect.  If 

you run into any issues, you can safely delete this file - AIMS will regenerate it with 

default values. 

 

Preferred Formatting 
The preferred formatting settings are stored in the formatPattern.preferences file.  From 

AIMS, select Help > Show Settings Directory..., then open the config 

directory.  Using a UTF-aware editor (like jEdit), you can change the patterns that AIMS 

uses when displaying values to the screen.  Here’s an example file for LDV/PDI 

systems: 
 

#Format Pattern Preferences 
#Fri Aug 05 12:51:11 PDT 2011 
${LDV_Channel1_DataRate}=\#,\#\#\#,\#\#\#.0 
${LDV_Channel1_Time}=0.000 
${LDV_Channel1_VelocityHistogram}=0.000 
${LDV_Channel1_VelocityMax}=0.000 
${LDV_Channel1_VelocityMean}=0.000 
${LDV_Channel1_VelocityMin}=0.000 
${LDV_Channel1_VelocitySampleStandardDeviation}=0.000 
${LDV_Channel1_Velocity}=0.000 

 
In the above example, mean velocity values will be displayed with three decimal places - 

for example 10.346.  To change this scientific notation, the velocity mean line would be 

changed to: 
 

${LDV_Channel1_VelocityMean}=0.000E0 

 
and would be displayed as 1.035E2. 
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The following table explains the possible format values: 
 

Symbol Meaning 

0 Digit (always shown) 

\# Digit, not shown if leading zero (for example, \#,\#\#\# would display 3452 as 

3,452 and 234 as 234). 

. Decimal separator 

E Scientific notation 

 
Note that the hash/pound symbol (#) must be escaped/preceeded with a slash (\). 
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CHAPTER 9 

     PDI calculations 

 

CALCULATIONS 
 
This chapter describes the methods by which the software interprets the raw information received from 

the instrument and computes information to obtain droplet velocity and size.  The software resolves the 

stored raw data into the velocity and size measurements for each particle and then computes the 

remaining statistical parameters.  This section describes the calculations completed by the computer. 

The nomenclature for this chapter is as follows: 

∆ Spatial Wavelength 

δ Fringed Spacing 

φ12,  φ13,  φ23 Phase shift in degrees between detectors 1 and 2, 1 and 3, and 2 and 

3 (also called A, B, and C) 

Θ Receiver Collection Angle 

γ Laser Beam Intersection Angle 

α, αr Aperture width, resultant aperture width 

Dmax Diameter of the largest particle size 

D10, D20, D30, D32 Mean particle diameters: Arithmetic, Area, Volume, Sauter 

d Diameter of spherical particle 

f, fD, fm,fr,fs, ft Frequency: Doppler, mixer, raw, shift, transformed 

I, ,Ii, Io, Is Light Intensity: incident, maximum at r = 0, scattered 

i Histogram Bin Number 

j or n Number of samples in histogram bin 

Κ Optical constant 

ND Number Density 

n, nc Number of samples in each bin: corrected size count 

PA Probe Area 

PV Probe volume That 

PVC Probe Volume Correction 

PVO Probe volume cut off 
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RL1, RL2 Receiver Lenses: Collimating, Focusing focal lengths 

rw or w Laser beam radius measured from the centerline of the beam:  

I = Io/e2 

S, S12, S13 Effect of detector separations: between detectors 1 and 2, and 1 and 3 

Σ Sizing Slope Factor 

τ Particle or droplet transit time through the probe volume 

t, ttot Time: total run time 

v Velocity 

VF or F Volume Flux 

 

 

Velocity Measurement 

The particle velocity is measured by the method typically used for laser Doppler velocimetry.  That is, as 

a particle crosses the interference fringes created by the two intersecting coherent laser beams, figure 

10.1, it refracts or reflects the local light intensity onto the receiver. The light intensity pattern projected 

onto the receiver and directed to the photomultiplier tubes produces a typical Doppler burst signal, figure 

10.2. The signal consists of a high frequency Doppler component superimposed upon the low-frequency 

Gaussian pedestal component.  The frequency of the signal is directly related to the velocity of the particle 

through the relationship 

 

dv f δ=  
 

The fringe spacing of the interference pattern is determined by the wavelength of the laser beam and the 

beam intersection angle and is given by the following expression 

 

2sin( / 2)
λδ
γ

=
 

 

The raw signal produced by the photodetectors and received by the signal processor is a combination of 

the Doppler frequency and the shift frequency produced by the presence of a Bragg cell. The signal 

frequency is given as 

 

r D sf f f= +  
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The raw signal is passed through a high pass filter set at 10 MHz (or 20 MHz) to remove the pedestal 

component of the Doppler burst signal and any low-frequency noise.  The signal is then combined with 

the mixer frequency and sent through a low pass filter to eliminate the high frequency components 

including the sum frequency from the mixer and any high-frequency noise. The remaining frequency is 

given as 

 

t r mf f f= −  
 

 
Figure 9.1: Schematic showing the laser beam intersection and the formation of interference 
fringes in the probe volume.  
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Figure 9.2: Simulated Doppler signals. 

 

 

Figure 9.3:  Typical Doppler burst signals for different trajectories through the probe volume. 
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This frequency is processed using the FFT programmed in the system computer.  The Doppler frequency 

is then obtained from the known mixer and shift frequencies and measured raw frequency using following 

expression 

 

D t m sf f f f= + −  
 

Size Measurement 

This section describes how the diameter of the particles is determined using the phase Doppler 

interferometer method.  The particle magnifies the interference fringe pattern onto the receiver to different 

degrees relative to a particle size.  The degree of magnification is measured by comparing the spacing 

of these fringes on the receiver detectors (spatial wavelength ∆) and the fringe spacing.  The diameters 

of the particles are determined using this relationship along with the receiver focal length and the sizing 

slope factor given as 

 

rFd
s
δ

=
∆ . 

 

A spatial wavelength, ∆ is determined by using the phase shift of the signal between the detectors in the 

time domain along with the calibrated spacing of the detectors. The spatial wavelength, ∆ is obtained 

from the weighted average of  

 

[ ]13 13 23 2312 12
12 13 23

12 13 23

360 /k S k Sk S k k k
φ φ φ

 
∆ = + + + + 

   
 

Artium Technologies, Inc. uses several proprietary methods for resolving the sizing slope factor for all 

possible transmitters/receiver configurations.  The slope is calculated assuming spherical particles and 

therefore, the particles to be sized should be spherical or near spherical if accurate results are to be 

obtained. 
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Figure 9.4: Schematic showing the interference fringes produced by the scattered light and projected onto 
the receiver lens. 
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Figure 9.5: Schematic showing the interference fringes formed by the scattered light and the pattern 
overlaid on the receiver lens and a description of how the droplets produce different phase shifts at the pairs 
of detectors. 

 

Probe Volume, Probe Area, and Probe Volume Correction 

The probe volume is a volume through which particles must pass to be measured by the PDI systems. 

Probe volume is defined by the focused laser beam diameter and the slit aperture width in the receiver.  

The shape of the probe volume can be estimated as a slice of a cylinder with oblique ends.  The width 

and angle of the slice are determined by the slit aperture width in the receiver, optics, and the angle of 

the receiver relative to the transmitted beams.  The intersecting beams are at a small enough angle such 

that they can be assumed as cylindrical in shape within the region seen by the receiver. 

 

The cylindrical diameter of the probe volume increases in diameter for increasing size classes of particles.  

This is due to the relation between the amount of incident light scattered by particle (proportional to the 

diameter of the particle squared) and particle size in conjunction with a Gaussian nature of the laser 

beam intensity profile illuminating the particles.  The amount of light incident on the particle is determined 

by the distance the particle passes from the center of the laser beams and its location along the trajectory 

through the beams.  For two intersecting laser beams the incident light is 
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2

2
2

( ) w

r
r

i oI r I e
−

=  
 

The intensity of the light scattered by particle is proportional to the particle surface area.  Combining the 

size relation with the above Gaussian equation results in the expression 

 
2

2
2

2 2( , ) ( ) w

r
r

s i oI r d KI r d KI e d
−

= ≈  
 

which is equal to the amount of light incident on the receiver optics relative to a particle size and position. 

 

A minimum amount of light incident on the receiver is needed in order for the instrument to detect a 

particle.  This intensity cut off determines the maximum radius r at which each particle size can be 

detected yielding a cylindrical diameter D as a function of the ratio of the probe volume diameters to 

particle diameter is 

 

2 2 2 max
max( ) 4 lnw

dD d D r
d

 = −  
   

which is used when calculating the probe volume correction, PVC. 

 

The maximum probe diameter is either assumed to be equal to a nominal value by using an analytical 

method for probe volume correction or is determined in situ by the transit time method.  The transit time 

is the time a particle spends in the probe volume which depends on its speed and the diameter of the 

probe volume.  The measured transit time multiplied by the particle velocity yields the particle path length 

within the probe volume.  Artium Technologies Inc. uses a proprietary method of combining the transit 

time of all particles passing through the probe volume to determine the maximum probe diameter. 

 

The probe area is determined from the maximum probe diameter of the maximum size bin and is given 

as 

 

max

sin
rD aPA

ϕ
=
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The resultant aperture size at the laser beam intersection is related to the aperture size within the receiver 

and the focal lengths of the receiver lenses. The resultant aperture size is given as 

 

1

2
r

RLa a
RL

 
=  

  . 

 

The number of particles in each size class of the distribution is multiplied by the probe volume correction 

factor to reflect the change in sampling volume with particle size and is given as 

 

( ) ( ) ( )cn d n d PVC d=  
 

The probe volume correction factor is simply the ratio of the probe area for the maximum particle size bin 

ratio to the probe area of each individual size bin d. Since the aperture and the angle of light scatter 

detection, Θ, remain constant, the ratio is determined only by the maximum probe diameter of each 

particle size class. 

 

max( )
( )

DPVC d
D d

=
 

 

The in-situ probe volume measurement and correction are dependent on certain factors in order to 

perform properly.  First, the laser beams must have a nearly Gaussian intensity distribution at the beam 

intersection.  The trajectory of the particles should be predominantly normal to the direction of the beams 

for a two-component system (two orthogonal velocity components measured).  For a one component 

system, the predominant trajectory of the particles should be in the direction of measurement of the 

velocity.  If these conditions are not met the analytical method to define the probe volume correction may 

be more accurate. 

 

Mean and Median Calculations 

 

In this section, the various mean diameters used in the presentation of data are presented.  These mean 

values are commonly used in spray analysis. 
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Arithmetic or Linear Mean Diameter (D10)   

( )
10

( )

c i ii

c ii

n d
D

n
= ∑

∑  

 

Area Mean Diameter (D20)    

2
( )

20
( )

ic ii

c ii

n d
D

n
= ∑

∑  

 

Volume Mean Diameter (D30)   

3
( )

330
( )

ic ii

c ii

n d
D

n
= ∑

∑  

 

Sauter Mean Diameter (D32)    

3
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32 2
( )

ic ii
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n d
D

n d
= ∑
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Total Number      ( )c ii
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Total Surface     
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Total Volume     

3
( )6 c i ii

tV n dπ
= ∑

 

 

Volume Fraction     

3
( )6

N
c i ii

n d
fV

tV

π

=
∑

 

 

 

Number Density and Volume Flux Measurements 

Number Density is a measurement of the number of particles per unit volume present in the 

measurement space.  There are two methods used to calculate number density and they are referred to 

as the swept volume method and the transit time method.  The total corrected count (corrected for probe 

volume) is divided by this volume to calculate the number density and is given as 

 

( )1
( )( )

c i
i

Tot i

n
ND

PA t v
= ∑

. 

 

A separate average absolute velocity is calculated for each size bin to eliminate the velocity biasing on 

the sampling statistics and is given as 

 

,i jj
i

v
v

n
=

∑
. 

 

With the transit time method which is favored, the number density is determined using the transit times 

for the particles as they pass the sample volume.  The transit time is the measure time that the particle 

spends within the probe volume.  This method uses the computed ratio of time duration when there is a 

particle in the probe volume to the total sample time for the measured distribution at that point.  Transit 

time ratio divided by the probe volume yields the number density given as 

 

,1 i jj
i

Tot i

t
ND

t PV
=

∑∑ . 
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This method is applied for each size class to accommodate the size biasing of the probe volume as a 

function of drop size. 

 

Both methods rely on an accurate probe area calculation.  The transit time method will work best as long 

as the beams are partially Gaussian at the intersection.  The swept volume method works well if the 

trajectories of the particles are normal to the direction of the beams in a two-component system or if the 

trajectories of the particles are in the direction of the velocity component measured for a one component 

system. 

 

Volume flux is calculated using the following expression 

 
3
30

6Tot Tot

tNDtVVF
t PA t PA

π
= =

. 

 

Mass flux can be calculated by multiplying the volume flux by the density of the spray drops or particles 

being measured. 

 

Liquid Water Content (LWC) 
 
The liquid water content is the volume of liquid water in a given volume of space. Liquid Water Content 

in gm/m3 is given as 

 

3
306

LWC D NDπ ρ=  

where ρ is the density of the liquid. 
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CHAPTER 10 

     Data analysis 

After the PDI hardware has been properly connected and the various software parameters have been 

properly set, data acquisition may be initiated by clicking on the green button in the software user interface 

page or pressing the F9 key. The following figures show the various data screens that can be viewed by 

selecting the appropriate tabs. These screens provide information on the drop size, velocity, mean 

values, and temporal information on the spray. A short description of the information on each screen is 

provided to aid the user in interpreting the data being acquired. By right clicking on any of the plots, the 

plotting parameters may be changed and the graph limits adjusted as desired. 

 

1D PDI Statistics 

 

Figure 10.1: Diameter histogram and velocity histogram. 
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Figure 10.1 shows the screen that displays the histograms of the size and velocity distributions for the 

measured spray. Note that for the example shown, the spray size distribution has a characteristic log 

normal shape, but it appears to have a slight increase in counts at around 75 µm. Note also that the 

velocity distribution appears to be bimodal. This behavior can be further understood by also looking at 

the size velocity correlation shown in a subsequent screen, Figure 10.5. In short, smaller drops for this 

spray relax to the ambient flow speed whereas larger drops continue to move at a greater speed because 

of their initial momentum. Reduced mean values are shown in the right-hand column along with the 

number of drops measured and the data rate. 

 

1D PDI Statistics (PVC) 
 

 
Figure 10.2: Probe volume corrected diameter histogram and velocity histogram. 

 
Figure 10.2 is similar to Figure 10.1 except that the data have been corrected for the effect of varying 

sample volume on the drop size. Since smaller droplets have a smaller effective sample volume, the 

number in each size bin must be increased by a factor equal to the ratio of the sample volume for the 

largest drops to the sample volume for the drops in each size bin. This normalization approach 
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compensates for the sample volume affect by increasing the number of drops in the smaller size bins. 

As noted from the mean values, especially D10, the mean size is decreased by the sample volume 

correction. It is important to note that the sample volume correction is necessary for an accurate 

measurement of the size distribution. This is the size distribution that should be reported. 

 

1D PDI Time History 
 

 

Figure 10.3: Time history plot of diameter and velocity. 

 

Figure 10.3 shows each drop size and velocity measurement as a function of the time of arrival. Each 

point on the plot represents one drop measurement. This information is useful in determining if there is 

any unsteadiness, clustering, or other temporal phenomenon in the spray. For example, pulsatile sprays 

can be observed to reveal pulse variations in the spray. If the spray is interacting with turbulent flows, 

spray drop clustering may be observed in this plot. By right clicking on the plot, any section of the time 

record can be selected and expanded to observe the details. 
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1D PDI Strip Chart 
Figure 10.4 also shows the diameter and velocity information as a function of time but displays it as a 

strip. This display is useful for viewing long time records over a short, elapsed time period to observe any 

time-dependent details in the spray. 

 

 

 

 

Figure 10.4: Strip chart plot of diameter and velocity. 

 

Velocity vs. Size 
Figure 10.5 shows a very useful plot for observing the droplet dynamics. Each point on the graph is a 

single drop measurement of the drop and velocity. In this case, it is easy to see that the small drops have 

relaxed to the slower ambient flow velocity and that the larger drops have a higher velocity because of 

their greater initial momentum.  
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Since the PDI instrument responds to droplet flux, the relative velocity of the drops will affect the size 

distribution. To convert the size distribution to a concentration dependent distribution, the number of 

counts in each size bin needs to be normalized to remove the effect of the drop velocity for each size 

class. This needs to be done, for example, when the results are being compared to imaging techniques 

or to a line-of-sight ensemble light scatter detection method. The shape of this size versus velocity plot 

also helps to explain the shape of the size distribution described previously. Counts in the bins of the size 

histogram are affected by the relative velocities of the drops in the different size classes. 
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Figure 10.5: Examples of Velocity vs. Diameter plots. 
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PDI Volume 

 

Figure 10.6: Volume distribution (PVC and non-PVC). 

 

 

Figure 10.6 shows the volume contribution for each size class of the spray drop size distribution. Also 

shown in the plot is a cumulative volume contribution for the various size classes. The 0.5 point on the 

plot is used to obtain the median volume diameter (MVD). The upper plot shows the size distribution that 

has been corrected for the probe volume affect (PVC) whereas the lower plot is the volumetric 

contribution for the uncorrected raw data (Non-PVC). The PVC corrected data is what should be used in 

reporting the measurements. 
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ASA Validation 

Figure 10.7: Channel 1 data validation results. 

 

Figure 10.7 shows the screen that provides information on the percentages of attempted measurements 

that pass the various criteria before a measurement is accepted as a valid estimation of the drop size 

and velocity for Channel 1. The validation percentage provides an indication of the quality of the signals 

being detected but low validation rate does not necessarily mean that the instrument is making faulty 

measurements. Our proprietary digital Doppler signal detection method is programmed to detect signals 

based on their coherency (whether or not they have sinusoidal characteristics). Since we do not want to 

miss any droplets the detection is set to attempt measurements of even low amplitude, low SNR signals. 

The small drops will produce the weakest signals with low amplitude and low SNR, but we do not want 

to bias the measurements by missing the small drops in the distribution. Furthermore, false signal 

detections will be discarded once the signals are processed with the full complex FFT and the remaining 

validation criteria have been applied. If the detection is set too conservatively, the validation will be very 

high but at the expense of missing the small drops.  
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Our innovative burst signal detection system has been designed to reliably detect even the smallest 

signals while minimizing false signal detection. Thus, the validation rates are usually high. However, in 

difficult sprays (dense sprays, sprays with very small drops but that are large in area, etc.) the validation 

rate may be expected to fall somewhat. 

 

Each of the validation criteria have been described in the Device Control section under the Validation 

Tab. The rates shown here are in response to the criteria described in that section.  

 

ASA Settings 
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Figure 10.8: ASA Processor settings. 

 

Figure 10.8 shows the screen that provides a summary of the ASA signal processor settings for this 

measurement point. This information is saved with the data file and allows the user to recover the settings 

for that data and if desired, repeat the measurements with those settings.  

 

LDV/PDI Optics 
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          Figure 10.9: LDV/PDI Optics Settings. 

 

Figure 10.9 provides the information on the optical setup used to acquire this data point. This information 

is stored with each measurement so that the user may, for example, recover this information and if 

desired, repeat the measurement at the same conditions or assess whether the setup was correct or not.  
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APPENDIX A 

     Theory of operation 

 
PHASE DOPPLER INTERFEROMETRY 

 
Bachalo (1980) theoretically described the light scattering from spherical particles and showed that the 

phase shift of the light scattered from two intersecting beams could be used to accurately and reliably 

measure the diameter of spherical particles. With the use of pairs of detectors to enable the measurement 

of the interference fringe pattern formed by the far field interference of the scattered light, a method for 

reliably and accurately measuring spray drop size even in difficult measurement environments was 

realized, Bachalo and Houser (1984). Following the initial development of the phase Doppler 

interferometry method, significant research and development has been devoted to the improvement of 

this important instrument and numerous publications have been written on the subject [Bachalo et al. 

(1993); Dodge (1987)]; Sankar et al. (1991); Sankar and Bachalo ((1995); Bachalo and Sankar (1988); 

Bachalo and Houser (1985); Bachalo et al. (1988); Ibrahim et al. (1990); Ibrahim et al. (1991); Ibrahim 

and Bachalo (1992); Ibrahim and Bachalo (1994);]. 

  

The Phase Doppler Interferometer (PDI) instrument, formerly known as the Phase Doppler Particle 

Analyzer (PDPA), has advanced as the standard laser-based diagnostic instrument for simultaneously 

measuring the size and velocity of individual spherical particles in polydisperse flow environments. The 

success of the method may be attributed to the measurement principles upon which it is based, namely, 

light scattering interferometry. Light scattering interferometry utilizes the wavelength of light as the 

measurement scale and, as such, the performance is not as easily degraded as it is for systems using 

light scattering intensity information for the estimation of the particle size. In addition, the method does 

not require frequent calibration. Over the decades, the instrument has proven to need only an initial 

factory calibration. The parameters affecting the measurement which include the laser wavelength, beam 

intersection angle, transmitter and receiver focal lengths, and the detector separation do not change with 

age and require deliberate intervention by the user or serious mistreatment of the instrument before they 

lose adjustment.  Another important characteristic of the method that is often missed is related to the 

signals generated by the device.  Unique sinusoidal signals are produced which can be easily detected 

even in the presence of noise using the Fourier analysis.  
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As an aid to understanding the measurement method, it will be useful to consider the simplest form of 

light scattering by a sphere. A geometrical optics description of the light scattering phenomena is 

illustrated in Figure A1. At the first interface, part of the incident light is reflected from the surface of the 

sphere and these rays are referred to as p = 0 following the convention of van de Hulst (1957). The light 

transmitted and refracted by the sphere is referred to as p = 1 rays and rays reflected from the interior 

surface and refracted in the backward direction are p = 2 rays. The relative light energy reflected from 

and transmitted through the sphere may be calculated using the Fresnel reflection coefficients.  

 

A schematic of the optical and electronics components for a basic PDI system is presented in Figure A2. 

The optical requirements are identical to that of a one-component laser Doppler velocimeter (LDV), 

except that three detectors are used in the receiver, and the receiver must be located at a known off-axis 

angle to the transmitted beams. The preferred light collection position for the receiver is at an off-axis 

angle of from 25 to 45 degrees to the transmitted beam direction measured from a plane passing through 

the two intersecting   beams.  The optical axis of the receiver should be in a plane that passes 

 

 

Figure A1: Simple ray diagram showing the deflection of the light rays incident on a spherical particle 
illustrating the p = 0, 1, 2, and 3 rays. 
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Figure A2: Schematic of the basic Phase Doppler Interferometer (PDI) system. 

 

through the intersection of the beams and is orthogonal to the plane formed by the two intersecting 

beams. Other receiver angles and configurations have been suggested but we do not recommend that 

they be used unless no alternative exists due to some other constraints of the experiment. 

 

In the basic PDI optical system, the laser beam is split into two beams of equal intensity. The beams are 

then focused and made to intersect using a transmitter lens. Frequency shifting is used to compress the 

frequency dynamic range and resolve the direction ambiguity that would occur for drops passing in a 

reverse direction. Particles passing through the beam intersection will scatter light that is collected by the 

receiver lens. A single aperture is used in the receiver to allow only light scattered by particles crossing 

a small region of the beam intersection to reach the photodetectors. Shown in figure A3 is a schematic 

depicting a spherical particle located at the intersection of the two laser beams. An enlarged view of the 

sphere with a light ray from each beam incident upon it is also shown. Since the rays from each beam 

enter at different angles, they must pass on different paths to reach a common point P. The sphere has 

an index of refraction, m, that is different than the surroundings. Thus, the difference in the optical path 

length of ray 1 from beam 1 relative to ray 2 from beam 2 will produce a phase shift between light waves 

traveling in the directions shown by ray 1 and ray 2 to the point P. An interference fringe pattern will form 

in the distant space surrounding the drop. Under ideal conditions, the interference fringe pattern will have 

a sinusoidal intensity distribution and will form a hyperbolic set of curves when projected onto a plane. 
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The wavelength of the pattern at a given location will be inversely proportional to the drop diameter. This 

phase shift can be calculated easily and exactly using the geometrical optics theory. Given a specific 

location in space (points on the receiver lens aperture) the phase shift between the light scattered from 

each beam will vary in proportion to the drop diameter. 

 

 

Figure A3: Simple diagram showing the light rays and waves incident on a spherical particle and the 
phase shift resulting from the passage of the light through the drop on different optical paths.  
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Figure A4: Scheme used for rapidly measuring the spacing, L of the interference fringes produced by the 
scattered light. 

 

Measurement of the spacing of the interference fringes produced by the scattered light is accomplished 

in a straightforward manner using pairs of detectors, figure A4. For this approach, pairs of detectors are 

located in the fringe pattern, or an image of it, and the separation S between the detectors is known. 

When the particle or drop is moving, the usual Doppler shift in the frequency of the scattered light occurs. 

The difference in the Doppler frequency shift between the light scattered from beam 1 and beam 2 causes 

the fringe pattern to appear to move.  

 

As the pattern sweeps past the detectors at the Doppler difference frequency, each detector produces a 

signal that is similar in frequency but shifted in phase. The phase shift is related to the spacing of the 

scattered fringe pattern through the following relationship: 

 

360O
s φ

=
Λ                                                                                

 

where s is the detector spacing and φ is the phase shift between the signals. The wavelength Λ is the 

spacing of the interference fringes formed by the scattered light and is inversely proportional to the drop 

diameter. Three detectors are used to avoid ambiguity in the measurements, to provide redundant 

measurements of the pattern, and to improve the resolution for the small particles. The ambiguity could 

occur when the fringe spacing, Λ is less than the detector separation. In this case, the phase shift would 

be greater than 360 degrees but is reported as φ - 360. 

 

A unique three-detector separation arrangement originally invented by Bachalo (US Patent 4,540,283) 

and first reported in 1982 (NASA Technical Report) is shown in figure A5. The phase versus diameter 

curves that correspond to these detector separations are also shown. With this configuration, the phase 

shift between the signals from the closely spaced detectors, D1 and D2 follow the smaller slope on the 

phase-diameter plot indicated by the dotted lines. The phase between the signals for the detectors with 

the larger spacing, D1 and D3, follow the curves with the greater slope. With this arrangement, the phase 

may be measured for detector separations that extend over several fringes (1 fringe corresponds to a 

measured phase shift of 360°) when placed in the field of the scattered light. More recently (patent 

pending), Bachalo has reported the use of three pairs of detectors (φ12,φ13, and φ23) to be used in the 

measurement as shown in the updated diagram of phase versus diameter 
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Figure A5: Three-detector configuration and the resulting phase diagram used to avoid ambiguity and 
extend the measurement range with high resolution. 

 

It is relatively easy to see that the interference fringe pattern produced by reflection will appear to move 

in the opposite direction to that produced by refraction. With the three detectors set to detect the phase 

shift for refraction, as shown in figure A6, the correct phase shifts for φ12, φ13 and φ23 will be detected. 

However, when the dominant light scatter is by reflection, the wave will travel in the opposite direction. 

For this case, the relationship between φ12, φ13, and φ23 will no longer pass the phase comparison 

criteria so these samples will be rejected. 

 

Unfortunately, spray droplets will also pass on trajectories through the Gaussian beam, which will result 

in a significant superposition of scattered light intensity by reflection and refraction. In this case, the 

resultant interference fringe pattern is no longer a pure sinusoidal wave but a superposition of several 

interference patterns. Additional means are required to reject particles passing on these trajectories to 

avoid or minimize measurement errors. Bachalo (1980) recognized this problem, and it was the primary 

reason for selecting the 30o light scatter detection angle wherein refraction is approximately 80 times the 

reflection (assuming a uniformly illuminated sphere). Bachalo and Houser (1984) addressed this problem 

experimentally by traversing monodisperse drops along controlled trajectories within the measurement 

probe volume for a range of drop-size-to-beam-diameter ratios. Fortunately, the redundant phase 

information coupled with other information has been proven successful in mitigating or eliminating this 

source of measurement error.  
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Figure A6: Three-detector configuration used by Bachalo, 1982 to resolve the phase ambiguity and to 
extend the measurement range and resolution. 

 

The key parameter in the analysis of this problem is the drop diameter-to-beam diameter ratio, Γ = d /Do 

where d is the drop diameter and Do is the diameter of the focused beams at the sample volume, figure 

A7. At this point, it is useful to consider the problem in three regimes: particles smaller than the focused 

beam diameter, (Γ << 1) particles similar in size (Γ~1), and particles larger than the beam diameter (Γ 

>>1). In the first case, the particles can be assumed to be approximately uniformly illuminated so the 

trajectory error is not a problem. In the case of the particles being of similar diameter to the focused beam 

diameter, the trajectory problem is most difficult since the scattering intensities from reflection and 

refraction can be of similar order producing a complex interference fringe pattern with a progressively 
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increasing magnitude of error. If the particles are larger than the focused beam diameter, then either 

reflection or refraction will dominate the scattering. For this case, the phase ratio will be effective in 

rejecting signals produced by the wrong scattering component. 

 

 
 

Figure A7: Schematic illustrating the three drop size cases passing a Gaussian beam; <<1, ~1, and 
>1. 

 

Sankar et al. (1992) have shown that the trajectory-dependent sizing errors can be minimized by the 

proper selection of the optical parameters, namely, the beam intersection angle and using the two-

detector-pair arrangement of the PDI. This work represented the first recognition of the importance of the 

relative phase difference between the reflected and the refracted light in resolving the trajectory-

dependent error problem. Increasing the beam intersection angle serves to increase the difference 

between the phase of light scattered by refraction and reflection, allowing a more effective discrimination 

using the phase ratio from the two pairs of detectors. In a later paper by Sankar et al. (1995), it was 

shown that with the proper selection of the optical parameters, the phase Doppler response for particles 

passing along the error-prone trajectories could be forced to always result in a size over-prediction, if at 

all, and never an under prediction. This information can then be used in conjunction with the scattered 

light intensity level for each particle to eliminate the erroneous measurements (Bachalo, US Patent 

4,986,659). 
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The intensity validation method is based on the observation that when particles pass on the “bad” 

trajectories near the edge of the beam, the incident intensity and hence, the scattered light is at least an 

order of magnitude lower than for particles passing on a trajectory through the center of the beam. In 

addition, if the light scattering by reflection is detected, the signal will be approximately two orders of 

magnitude lower than for the light scattered by refraction because of the lower light scattering efficiency. 

Thus, calculating a minimum acceptable light intensity level for each size class and measuring the signal 

amplitudes along with the drop size can provide information for eliminating the particles passing on the 

trajectories susceptible to errors from consideration. Using this approach, the definition of the edges of 

the sample volume are better defined at higher levels than is possible on the wings of the Gaussian 

wherein a small uncertainty in amplitude corresponds to a large change in the size of the sample volume. 

Detailed experimental studies and theoretical simulations have been conducted to evaluate the reliability 

of the intensity validation method. Sankar et al. (1995) and Strakey et al. (2000) have shown that the 

method is effective in controlling trajectory errors.  

 

 
 

Figure A8: Plot showing the light scattering intensity and the measured drop size for a monodisperse drop 
stream traversed through the sample volume from one side to the other. 

 

Numerous experimental evaluations of the method have been conducted. Figure A8 shows the results 

of traversing a monodisperse stream of droplets through the probe volume. The drops had a nominal 

size of 132 µm. The plot shows the resulting light scattering intensity which is nearly Gaussian and the 

measured size as the stream is traversed from one side of the beam to the other (-100 µm to +100 µm). 

180

140

120

100

80

60

40

20

160

Mean Drop Diameter
Mean Signal Intensity

-100 -60 -40 -20 0-80 20 40 60 80 100

Size Cutoff

Intensity
Threshold

Actual Size

Radial Position Across the Beam



 

Confidential and proprietary information of Artium Technologies, Inc. 
UNAUTHORIZED USE, REPRODUCTION AND/OR DISTRIBUTION IS STRICTLY PROHIBITED. 

 

 
105 

The scattered light intensity profile will not be completely Gaussian in shape since the light scattering 

mechanisms change from one side of the beam to the other (more reflection detected on one side as a 

result of the location of the receiver). If a threshold intensity level is set (as shown in figure A8) for each 

drop size class, the error in the measured size at the side with the reflective light scattering may be 

eliminated. For the “bad” trajectories, the measured size begins to deviate from the true value but setting 

a threshold signal amplitude level serves to exclude these readings. In principle, the adaptive threshold 

validation method limits the region of detection over the sample volume for each particle size class. 

 

Examples of PDI Applications 
Numerous examples are available in the literature wherein the PDPA has been used to investigate spray 

characteristics in highly complex environments. This includes study of sprays injected into turbulent flow 

fields, reactive fuel sprays in swirl-stabilized combustors, characterization of rocket injectors in a high-

pressure environment using cryogenic liquids, and the study of transient fuel sprays such as in spark 

ignition (SI) and diesel engines.  The usefulness of the PDPA (now referred to as the PDI instrument) in 

understanding various complex spray and combustion processes becomes apparent through the 

following brief description of some of the results that have been obtained to-date by various researchers.  

 

Spray Combustion Measurements 
The development of the Phase Doppler Interferometer (PDI) has enabled the detailed measurement of 

drop size, velocity, number density and volume flux in realistic spray combustion environments [Bachalo 

et al. (1990); Edwards and Rudoff (1990)]. Chehroudi and Ghaffarpour (1991) investigated the effects of 

swirl and dilution air flow rates on the shape and stability of a kerosene flame on a model combustor with 

comparisons made of the non-combusting and combusting cases. The gas temperature was also 

measured within the flame using a thermocouple. Flow visualization showed nonuniformly-distributed 

separated finger-like regions of visible flames wrapped around the spray sheath. These structures were 

possibly due to large-scale eddies formed by the swirling flow. At the center of the spray, drops with a 

reversed flow velocity were measured indicating a region of recirculation, figure A9. In the burning case, 

no drops were detected in this region indicating that only vitiated air is recirculated toward the injector.  At 

the uppermost end of the flame brush, a significant number of large drops were measured with velocities 

of approximately 10 m/s indicating that unburned drops were exiting the flame. 

 

Transient Fuel Sprays 
Transient spray injection such as that used in Diesel and spark ignition engines shows some unique 

atomization characteristics. Diesel injection may take place into a relatively quiescent environment at 

pressures of approximately 15 atmospheres and at injection pressures of between 50 and 180 MPa. The 
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important combustion parameters are the fuel penetration, mixing, and vaporization. These parameters 

depend upon the spray drop velocity and trajectory, the drop size distribution, and the turbulent gaseous 

flow field. The characterization of sprays having droplets of high velocity, small diameter, and high 

number density, which are typical of Diesel engines, is a challenging task, Harrington (1995). This is 

particularly true for smaller bore, light-duty, and medium-duty Diesel engines that utilize relatively short 

distances from the injector tip to the piston-bowl impact point. The combination of the above factors with 

high beam extinction in the spray core, and the need for a high pressure optical chamber, leads to 

difficulties in all laser diagnostic methods. In spite of these challenges, the advanced frequency domain 

signal processors that are available for the PDPA has allowed for the reliable characterization of Diesel 

sprays. 

 

Figure A9: Drop size and velocity data obtained in a swirl-stabilized combustor comparing the results with 
and without combustion. The solid symbols are for the reacting case. Also shown is the gas temperature 
(solid line) obtained with a thermocouple (Courtesy of Chehroudi and Ghaffarpour [1991]).  
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Figure A10:  Air flow rate effect on drop size and velocity fields inside a SI engine cylinder. 

 

As with Diesel engines, the atomization for spark ignition (SI) engines is highly transient and must be 

accomplished over a wide range of operating parameters. Vannobel et al. (1992) have used the PDPA 

to perform measurements in a gasoline spray inside the inlet port and downstream of the induction valve 

of a SI engine. Their interest was in studying quality of the air/fuel mixture and its dependence upon 

injection timing, injector position, and orientation within the manifold. The PDPA measurements were 

made inside the engine cylinder. The various curves in figure A10 representing the different air pressures, 

illustrate the trajectories followed by the drops.  
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